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Preface 
This document has been written for an audience with an intermediate understanding of Microsoft Windows 

based computer operating systems, networks, and anti-virus/antimalware software. It is assumed that said 

audience will have administrative rights and permissions to these areas. 

It does not assume that the reader has any knowledge of how to use AccuMap and/or AccuLogs. 

Detailed in the following pages are the steps involved to best prepare an IT environment for the implementation 

and use of AccuMap, AccuLogs, and the AccuMap License Manager Service.  

Please note that failing to follow the guidelines provided in this document can lead to performance issues for 

end users.   
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Introduction 

AccuMap 
AccuMap is an oil and gas mapping, data management and analysis software which consist of a series of 

databases containing information on subsurface land, well, pressure, production, pipeline, core, reserve, 

seismic, and logs for the Western Canadian Sedimentary Basin and Frontier areas. 

AccuMap databases and program files are typically installed on an application server whereby clients run 

workstation set-ups to access the information through a front-end interface. Updates to the databases occur 

twice a month while updates to the program files generally occur monthly. There are also two separate data 

versions of AccuMap, IPL and ACD. The main difference between them is the codes which are used to 

represent the various formations. 

Access to these databases (modules) is controlled by the AccuMap License Manager Service – a Windows 

service which keeps a constant track of the modules in use and which either grants or denies access to them 

based on the number of seats contained in the AccuMap License File. Failure to have the service installed and 

running will prevent a successful start-up of AccuMap. 

 

AccuLogs 
AccuLogs is a software program that must be run within AccuMap but which primarily interacts with and 

provides data from the IHS Information Hub – an online repository of data which contains millions of depth 

registered raster well log images and digital LAS files. As with AccuMap, there are two different data versions 

of AccuLogs, IPL and ACD. The version chosen during installation should match the version chosen for 

AccuMap. 

AccuLogs program files are typically installed on the same server as AccuMap and like AccuMap; AccuLogs 

also requires that a workstation set-up be done. Licensing for AccuLogs is granted and maintained by both the 

AccuMap License Manager Service, the AccuMap License File, and through an external database maintained 

by the IHS Licensing Department. In addition, for AccuLogs to connect to the IHS Information Hub, a secure 

network connection to IHS servers must be in place. Information on acquiring this connection is beyond the 

scope of this document as it is handled independently by the IHS Connections Department. 
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System Requirements 
AccuMap & AccuLogs support either local installation (standalone) or a standard client-server installation in a 

“parallel” version configuration. 

The following system specifications are not intended as an endorsement of specific brands, hardware, or 

software manufacturers; individual deployments will have results dependent on a variety of factors (i.e. video 

card chipset & drivers, internal network conditions, type of application deployment, etc.) 

 

Client Workstation Requirements 
AccuMap & AccuLogs will function when using hardware that meets the minimum hardware/software 

requirements; however, the performance may not meet end user expectations. 

 

Recommended 
IHS recommends a system matching or better than the following specifications for general users of AccuMap. 

CPU: Intel Quad Core i5 2.90 GHz (or AMD Equivalent) or better 

RAM: 8GB 

Storage: 1GB of free disk space (Networked Client) or 18GB of free disk space (Standalone Install)  

Operating System: Windows 7/8/10 (64bit) 

Network: 1Gbps Network Connection 

Graphics/Video Display Card: Capable of screen resolutions of 1024x768 or higher 

Printer: Any Windows-compatible printer or plotter 

 

Preferred 
This is suggested for power users and geologists that will usually operate with multiple programs and map files 

open at the same time.  

CPU: Quad Core i7 3.50 GHz (or AMD Equivalent) or better 

RAM: 16GB or more 

Storage: 1GB of free disk space (Networked Client) or 18GB of free Solid State Disk space (Standalone 

Install)  

Operating System: Windows 7/8/10 (64bit) 

Network: 1Gbps Network Connection 

Graphics/Video Display Card: Capable of screen resolutions of 1024x768 or higher 

Printer: Any Windows-compatible printer or plotter 

 

Minimum 
While AccuMap will operate at this level please be advised that application performance will suffer. Multitasking 

between different applications or working on more than a single map at once can result slow redraws, printing 

issues, and delayed workflows.  

CPU: 2.6 GHz Intel Core2 Duo (or AMD Equivalent) multicore processor 

RAM: 4GB 

Storage: 1GB of free disk space (Network Client) 18GB of free disk space (Standalone Client) 
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Operating System: Windows 7 32bit 

Network: 100Mbps Network Connection 

Graphics/Video Display Card: Capable of screen resolutions of 1024x768 or higher 

Printer: Any Windows-compatible printer or plotter 
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Server Requirements 
Many factors such as the total number of users, other applications running on the same server, etc. will have a 

varying effect on server performance in different environments. 

Regarding AccuMap performance on the server side there are two areas that will play the largest part in 

ensuring that the application operates at its best for either virtual or dedicated server install types.  

 Network Speed – The connection from the server to the end user should be as good as possible. 1Gb 

network connections from the workstation will ensure that the large amount of read actions AccuMap 

performs are dealt with quickly.  

 Disk Speed – The storage array or disks that the AccuMap install is located on should be running at 

7200rpms or better to allow for improved I/O. In most cases data arrays are operating at 10000 RPMs 

or faster so this most likely isn't a big concern. The best possible choice would be to host the install on 

an SSD array.  

 

Recommended 
The recommended specifications are based on the Windows Server 2008 recommended system requirements 

and are provided as a suggestion.  

http://technet.microsoft.com/en-ca/windowsserver/bb414778.aspx 

CPU: Intel Xeon 2 GHz (or AMD Equivalent) or better 

RAM: 8GB or more 

Storage: 60GB of free disk space or more 

Operating System: Server 2008(R2)/2012(R2)/2016 

Network: 1Gbps Network Connection or faster 

Graphics/Video Display Card: N/A 

  

http://technet.microsoft.com/en-ca/windowsserver/bb414778.aspx
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Software Requirements 
Required software that needs to be installed on end user machines prior to installing AccuMap 

 .Net Framework 3.5 

 .Net Framework 4.0 

 .Net Framework 4.5 

 .Net Framework 4.6.11 

 Microsoft Visual C++ 2010 Redistributable2 

 Microsoft Visual C++ 2013 Redistributable3 

 Microsoft XPS Document Writer 

 Microsoft Office 2007 (or newer) 

 Adobe Acrobat Reader (8 or higher)4 

 Golden Software Surfer v10 (or newer)5 

 
 

Network/LAN 
For best results your LAN should be running at 100/1000 (1Gbps) speeds; however, the software will operate 
at 10/100 (100Mbps) at the expense of application performance. 
 
 

End of Life Information 

Windows XP 
In response to Microsoft’s decision to bring Windows XP to end of life on April 8th 2014, IHS will discontinue 
support for AccuMap & AccuLogs running on Windows XP machines as of December 31, 2014.   
 
IHS will continue to support AccuMap & AccuLogs running on Vista, Windows 7, Windows 8(8.1), and 
Windows 10. 
 

Windows Server 2003/R2 
Currently Microsoft has a set end of life date for all versions of Windows Server 2003/R2 for July 14th, 2015. 
https://support.microsoft.com/en-
us/lifecycle/search/default.aspx?alpha=Windows%20Server%202003%20R2&wa=wsignin1.0 
 
IHS will discontinue support for AccuMap & AccuLogs running on Windows Server 2003/R2 as of July 14th, 
2015. 
 
While Servers running both 2003 and 2003R2 will continue to work as file servers to install AccuMap and 
AccuLogs on, operating the application or installing from the server level will no longer be supported. This is 
due to the lack of .Net support on this server platform from Microsoft. 
 
In order to continue using 2003/2003R2 install, server administrators will need to run any application updates 
or management tools for AccuMap and AccuLogs from a workstation machine.  
 
IHS will continue to support AccuMap & AccuLogs installed on Windows Server 2008, 2008 R2, 2012, 2012 
R2, and 2016.  

                                                           
1
 Required as of October 2016 

2 Both the 32bit & 64bit installs should be applied to end user work stations.  
3
 As of October 2015, AccuLogs will require the Microsoft Visual C++2013 Redistributables installed on every desktop that will be upgraded to AccuLogs 8.3. Both the 

32bit & 64bit installs should be applied to end user work stations. 
4
 Only required if end users require PDF capabilities.  

5 Only required if end users are performing contouring tasks through AccuMap 

https://support.microsoft.com/en-us/lifecycle/search/default.aspx?alpha=Windows%20Server%202003%20R2&wa=wsignin1.0
https://support.microsoft.com/en-us/lifecycle/search/default.aspx?alpha=Windows%20Server%202003%20R2&wa=wsignin1.0
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Anti-Virus / Antimalware 
Actively scanning anti-virus and antimalware platforms can have an adverse effect on the performance of 
AccuMap and AccuLogs. With the proper implementation of exclusions however these effects can be avoided 
and allow for a superior end user experience.  

 

Exclusions 
Depending on which type of Anti-Virus/Antimalware you are running some exceptions will need to be applied to 

ensure the best AccuMap & AccuLogs performance.  

UNC paths should be used for exclusions in place of mapped drive locations. 

 

Files 
The following files are broken down by location and should be added to your exclusion lists.  

 

AccuMap Settings Folder  

By default located in the end users AppData folder (Example: %appdata%\accumap\settings) 

 AccuMap.config 

 AccuMap.log 

 AccuMapMapMRUFiles.ini 

 AccuMapMapMRUPlaces.ini 

 appdatalist.txt 

 ControlStates.xml 

 DataCardMRULists.ini 

 DataCardPrintConfig.xml 

 InspectActionBindings.config 

 LayerTemplateCatalog.xml 

 ProductionGraphTemplates.xml 

 QuerySettings.xml 

 QuickSearchConfig.xml 

 RibbonDataCardConfig.xml

 

AccuMap User Directories 

Usually located at the root of the end users local primary drive (Example: C:\AccuMap\) 

 default.cfg 

 sssk.dat (if applicable) 

 ufatr.dat 

 ufatr.idx 

 userDirlist.txt 

 utopa.dat 

 utopa.idx 

 uwela.dat 

 uwela.idx 

AccuMap Shared Folder 

By default located in the root install folder of AccuMap (Example: *\Apps\IHS\Shared\) 

UNC paths should be used for exclusions in place of mapped drive locations. 

 Sssk.dat  Chdarea.lic  Orthoarea.lic (If licensed) 

File Types/Extensions 
Some platforms will still scan files despite being excluded based on heuristics. To avoid this, the following file 

extensions can be added to exclusion lists.  

For concerns regarding the exclusions of files types such as .bin or .dat, please see the section on Specific File 

Names.  
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Please note that * denotes a wildcard placeholder. 

 *.accumap 

 *.accumapindex 

 *.accumap_image_cache 

 *.axp 

 *.axs 

 *.bin 

 *.btr 

 *.cll 

 *.clx 

 *.dat 

 *.db 

 *.dbf 

 *.dct 

 *.dsc 

 *.huf 

 *.idx 

 *.inx 

 *.lns 

 *.ln0 

 *.ln1 

 *.ln2 

 *.lwell 

 *.map 

 *.mb 

 *.nme 

 *.pls 

 *.prj 

 *.pts 

 *.px 

 *.pt0 

 *.rgn 

 *.rg$ 

 *.idx 

 *.shp 

 *.shx 

 *.sx0 

 *.sx1 

 *.sx2 

 *.tbl 

 *.tct 

 *.tzn 

 *.var 

 *.vix 

 *.wls 

 *xsc 

 *.xs_ 

 *.xsection 

 *.xg0 

 *.yg0 

 

Executables/Processes 
These executables/processes are located in the root install folder of AccuMap (Example: *\Apps\IHS\Shared\) 

UNC paths should be used for exclusions in place of mapped drive locations.

 accucorn.exe 

 AccuMap.exe 

 AccuNet.exe 

 AccuXCore.exe 

 Current.exe 

 ddeview.exe 

 exportmgr.exe 

 IhsProfileViewer.exe 

 Incident Manager.exe 

 LicenseMonitor.exe 

 peepimp.exe 

 topsMgr.exe 

 Xsec32.exe 

 Xsv.exe 

 

Microsoft Exclusions 
The following Windows Processes and executables should be excluded from Anti-Virus scanning:

 Spoolsv.exe  Splwow64.exe 

Microsoft also provides comprehensive documentation on custom settings that can be applied for further 

performance improvements while running Anti-Virus/Antimalware in enterprise environments. 

http://support.microsoft.com/kb/822158 

 

Other Exclusions 

Golden Software – Surfer 

If end users are doing contouring via Surfer ensure that the Surfer.exe has been added to your Anti-Virus 

solutions exclusion list. Depending on your install type (32bit or 64bit) the executable is located within the 

Program Files folder.  

  

http://support.microsoft.com/kb/822158
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Platform Notes 
Depending on the anti-virus platform you are employing there may be addition notes below.    

 

BitDefender 
The free version of BitDefender only provides an on/off state in which to protect a machine and provides no 

configuration dialogs for specific customization.  

In the 2013/2014 version there is a bug that may result in exclusion lists being ignored, which in turn can result 

in slower AccuMap performance.  

If you are running the local BitDefender firewall you will also need to provide an exception for the AccuMap 

directories.  

Required exclusions can be found here. 

 

ESET 
It is important to note that with ESET you must add all necessary files to both the main exclusion list, as well as 

the “real-time file system protection”. Failing to add the required information in both sections will result in a 

slower performing AccuMap.  

Required exclusions can be found here. 

Copy & Paste Exceptions 

The following section provides you with preformatted entries that can be copy/pasted into your ESET Security 

application.  

File Types 
accumap, accumapindex, accumap_image_cache, axp, axs, bin, btr, cll, clx, dat, db, dbf, dct ,dsc, huf, idx, inx, lns, ln0, 

ln1, ln2, lwell, map, mb, nme, pls, prj, pts, px, pt0, rgn, rg$, idx, shp, shx, sx0, sx1 , sx2, tbl, tct, tzn, var, vix, wls, xsc, xs_, 

xsection, xg0, yg0, 

Network Scanning 

We advise that this feature be disabled on client/end user machines. If left on, while launching AccuMap this scanning 

tool can prevent the application from opening even with proper exceptions in place.  

 

LANDesk 
Exclusion entries are required in three separate sections of the LANDesk security platform to ensure proper 

performance of AccuMap. The "Real-time Protection" tab and "Virus Scan tab" in the anti-virus settings on the 

core server, as well as in the Trusted Items list on the client. 

For further information on adding exceptions: http://community.landesk.com/support/docs/DOC-6920 

Required exclusions can be found here. 

 

http://community.landesk.com/support/docs/DOC-6920
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Microsoft SystemCenter2012 / Endpoint / Security Essentials /Antimalware 
Due to the heuristic features of Microsoft’s anti-virus platform, files may still get scanned despite being located 

within an excluded directory or selected for individual exclusions. It is advised that the file extensions be added 

to the exclusion lists along with the listed processes and executables.  

Required exclusions can be found here. 

Copy & Paste Exceptions 

The following two sections provide you with preformatted entries that can be copy/pasted into your Microsoft 

Security application.  

Please note that there is a character entry limit in the Microsoft SystemCenter2012 / Endpoint / Security 

Essentials /Antimalware console. While the preformatted text below fits within this size limit, other entries may 

need to be adjusted to ensure nothing is missed.  

File Types 
*.accumap; *.accumapindex; *.accumap_image_cache; *.axp; *.axs; *.bin; *.btr; *.cll; *.clx; *.dat; *.db; *.dbf; *.dct; *.dsc; 

*.huf; *.idx; *.inx; *.lns; *.ln0; *.ln1; *.ln2; *.lwell; *.map; *.mb; *.nme; *.pls; *.prj; *.pts; *.px; *.pt0; *.rgn; *.rg$; *.idx; *.shp; 

*.shx; *.sx0; *.sx1; *.sx2; *.tbl; *.tct; *.tzn; *.var; *.vix; *.wls; *xsc; *.xs_; *.xsection; *.xg0; *.yg0; 

Processes 
accu32.exe; accucorn.exe; AccuMap.exe; AccuNet.exe; AccuXCore.exe; AdminConfigTool.exe; Current.exe; 

ddeview.exe; Exportmgr.exe; IHS.Layer.Downloader.exe; IHSProfileViewer.exe; LicenseMonitor.exe; 

Map.IHSLayerDownloader.Diagnostics.exe; Peepimp.exe; RegistarAccuMapComponents.exe; TopsMgr.exe; 

Specific Files 

A preformatted copy of all specific file exclusions is available if required. Please contact IHS directly to get a 

copy for Microsoft’s Antivirus platform.  

 

Symantec Endpoint Protection 
The Symantec product SONAR (Symantec Online Network for Advanced Response) currently only supports 

folder exclusions and not individual file extensions; in order to exclude the required file types the parent folders 

will need to be added to the exclusion lists. All entries should be excluded from all forms of scanning.  

Tamper Protection exceptions should also be created if you are using Symantec EndPoint Protection to avoid 

blocking AccuMap from making registries changes.  

Required exclusions can be found here. 

 

Symantec Scan Engine 
Symantec Scan Engine does not allow for specific files or extensions to be excluded from its scanning process; 

however tests performed internally at IHS show that is shouldn’t have an effect on application performance. It 

is advised however that the “Advanced Heuristics” feature, which is off by default, remain disabled.   

Required exclusions can be found here. 
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Trend Micro Office Scan 
Exclusions need to be entered in both the OfficeScan management console as well as the Worry-Free 

Business Security (WFBS) console. Manual and Scheduled scans should also be set to enable the exception 

lists.  

Required exclusions can be found here.  
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System Configuration 

Permission Requirements 
For network based installs users will need Read/Write/Modify access to the primary install location of AccuMap 
& AccuLogs (Example: Z:\Apps\IHS\) 
 

Shared Folder 
Keeping a clean and organized shared directory can have a major impact on the performance of AccuMap in a 

network install based environment.  

Common shared directories should be used for files that are used companywide such as proprietary layers or 

maps. Individual or specific groups within an organization should have their shared files kept in separate 

locations to prevent them from being loaded into each user’s machine when the application is launched.  

 

User Top Files 
Storing User Top files within the shared folder should be avoided as it can lead to broad performance issues 

for all users. The best method for users to share out their Top files is via a separate network folder from which 

users can access their desired specific files without having an effect on all users.  

 

Windows Firewall 
The following executables/processes should be allowed to pass through the Windows Firewall. All of these 

executables are located within the primary installation folder for AccuMap.  

If your organization employees an alternative local firewall application on end user machines the listed 

executables/processes should be added to the applicable exclusion lists. 

UNC paths should be used for exclusions in place of mapped drive locations. 

 accu32.exe 

 accucorn.exe 

 AccuMap.exe 

 AccuNet.exe 

 AccuXCore.exe 

 AdminConfigTool.exe 

 Current.exe 

 ddeview.exe 

 Exportmgr.exe 

 IHS.Layer.Downloader.exe 

 IHSProfileViewer.exe 

 LicenseMonitor.exe 

 Map.IHSLayerDownloader.Diagnostics.exe 

 Peepimp.exe 

 RegistarAccuMapComponents.exe 

 TopsMgr.exe 

 Xsec32.exe 

 Xsv.exe 

 

Other Local Firewall 
If your organization is using a separate third party local firewall on end user machine it is advisable that the 
same exceptions mentioned in the Windows Firewall section be applied.  
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Offline Files 
Offline files allow for network files and folders to be synced to a local computer for use when no connection to 
said network is present. For most IT environments this feature is generally ignored and/or unused and in most 
cases safely disabled with no end user issues.   
 
If not in use by your organization it is advisable to disable ‘Offline Files’ on end users machines. By default it is 
enabled in Windows versions Vista, 7, and 8, and disabled by default in Server 2008 & 2012. By leaving this 
feature enabled it on can result in unnecessary calls and checks on attached network drives, even if no files 
are in fact set to sync. These calls can have an adverse effect on network performance as well as read/write 
speeds of files.  
 

Disable Via GPO 
This feature can be disabled on a domain via GPO: http://technet.microsoft.com/en-
us/library/cc759721(v=ws.10).aspx 
 

Disable Locally 
To disable this feature locally follow these steps: 

1. From the Control Panel open Sync Center 
 

 

 
2. In the column on the left select “Manage Offline files” 

 

 

 
3. Select “Disable Offline files” button and reboot the machine when prompted 

 

http://technet.microsoft.com/en-us/library/cc759721(v=ws.10).aspx
http://technet.microsoft.com/en-us/library/cc759721(v=ws.10).aspx
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Sharing Wizard 
The ‘File Sharing Wizard’ is used in home network environments to allow for a simpler network setup. Much 
like Offline Files this feature will make extra calls to network locations even if it is not being utilized.   
 
Provided your environment is a Windows Domain you can safely disable this feature to prevent unnecessary 
calls and checks on attached network drives or viewable network devices. These calls can have an adverse 
effect on network performance. 
 

Disable Locally 
To disable this feature locally follow these steps: 

1. From the Control Panel select Folder Options 
 

2. Select “View” tab and scroll down to “Use Sharing Wizard (Recommended)” 
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3. Uncheck this option and select “OK” 
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Printer Configurations 
Printing performance and time can be affected by a number of different factors such as size or quality of the 

print job or network performance. The following recommendations can help reduce printing times for end users.  

 

General Printer/Plotter Settings 
Ensure that the latest drivers are always installed for your printer or plotter. In most cases performance issues 

with printing have been resolved by updating the drivers to their newest releases. 

Appropriately adjusting the driver settings either locally at the printer/plotter or via the end user driver settings 

can have a significant increase in printing performance and time.  

To avoid setting defaults that may not apply to all print jobs, these settings can be stored in preset modes that 

end users can select when they go to print from AccuMap or AccuLogs. 

The following settings have been generalized to apply to a number of different devices/manufactures and are 

accessed by the “Printer Preferences” option in the “Devices and Printers” window when you right click on a 

specific device. 

 Paper Type: Provide a set paper type at the Plotter or in the driver to reduce spooling/processing time. 

Generally, Plain paper settings work for the majority of printing done on plotters. Most often printers 

and plotters have this setting left at “Any”, which results in the device making assumptions on the 

paper type, increasing spooling time and file size. Whenever possible, select the specific type of paper 

being used by the plotter. 

 

 Paper Source: While generally left to the “Printer auto select” option, it is recommended that “Paper 

Source” be set to “Roll” for printing from AccuMap & AccuLogs when printing to a Plotter. Normal 

printers can still be set to a specific source or tray, provided it contains the proper paper size the end 

user wishes to print to.  

 

 Color Management: Presetting a default color management scheme can greatly reduce the print times 

associated with larger print jobs. Depending on the manufacture of your device this can be set to 

“Application” or “Printer”. Changing to “Printer” and selecting an appropriate color profile such as 

“sRGB” is recommended. By making this change you are telling the printer to handle color instead of 

AccuMap. 

The following settings have been generalized to apply to a number of different devices/manufactures and are 

accessed by the “Printer Properties” option in the “Devices and Printers” window when you right click on a 

specific device. 

 Spooling Settings: Having the spool settings set to “Start printing immediately” will result in the user 

regaining control over AccuMap faster after submitting a print job. 

 

Printer/Plotter Driver Types 
Fine turning the settings for your printer or plotters driver can result in a boost to their performance printing 

from AccuMap. Jobs should spool quickly and start printing in one minute or less. If the performance of your 

printing is poor, please refer to the following information to make the necessary adjustments to your driver.  
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PS or PostScript Drivers 
PostScript drivers result in the best performance from both plotters and general printers when working in 

AccuMap. Unlike PCL, PS drivers are betting suited to handle the vector based print jobs created within the 

application. In most cases the latest PS release will work best, but depending on the age of the printer or 

plotter PS3 drivers have also worked well.  

 

PCL Drivers 
PCL drivers should be avoided when attempting to print from AccuMap. While smaller prints (Legal size paper 

or smaller) generally tend to work fine larger print jobs can result in missing artifacts or graphics. This is due to 

PCL drivers poor handling of vector based print jobs. Users looking to print to plotters should be setup with 

either a PostScript driver or in the case of some HP plotters, the HPGL2 driver (using the proper settings). 

 

HPGL2 Drivers (HP Plotters) 
Much like the PCL, the HPGL2 driver is not always great at handling large print jobs. This can result in lost 

artifacts, missing details, and extremely slow spool times. To fix this, most HPGL2 drivers have the ability to 

handle all jobs as raster based Bitmaps.  

To make this change start by accessing the “Printer Properties” option in the “Devices and Printers” window 

when you right click on the printer or plotter in question and select either of the following tabs, depending on 

your printer model: 

 Services: Select the “Troubleshoot Software Problems” button at the bottom of the window. Disable 

“SpoolSmart” and enable “Send Job as Bitmap (Process in Computer)” 
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 Advanced: In the list of options, ensure that “Send Job as Bitmap” is set to “enabled” 

 

PDF Writers 
End users may experience very slow print times and large PDF file sizes when printing from AccuMap if the 
DPI settings for their PDF writers are too high. Default settings for DPI settings are dependent on the 
application being used and are generally in the 600-2400 range.  
 
In almost all cases PDF’s should be created at the 150-300 DPI range as there is little to no difference in 
quality to the end user. Within this range the quality of the file is still high enough to be edited or worked on in 
other applications such as Adobe Illustrator, but keeps the file size small and print times fast. 
 
Adjusting these settings for most PDF writers are as easy to change and can be set as a permanent change or 
adjusted for each print job. 
 

1. Go the computers "Control Panel" 
2. Select "Devices and Printers" 
3. Right click on the PDF writer you wish to adjust 
4. Select "Printer Preferences" 
5. Select the "Layout" tab and click the "Advanced..." button in the bottom right of the window 
6. Under the "Graphic" header, change the "Print Quality" setting to something within the 150-300 range. 

In most cases 300 DPI is the best choice.  
7. Click "OK" on the current window 
8. Click "OK" on the "Printer Preferences " window 
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AccuMap Downloader 
The AccuMap downloader utility enables you to download the latest version of the AccuMap update/ install files 

for Monthly and Currency updates through a simple one-click application.  

In the past downloading the later release from the AccuMap Updates website required the user to save four 

individual files to a desired location and unpacking them into a single directory. This system did not allow for 

the ability to schedule when the download took place or for a checksum to ensure zero file corruption or errors.  

As of AccuMap 25.03 (March 26, 2015) this new tool has been included with all updates and is located in the 

install directory of the application in the “AccuMap_Downloader” folder. You can also download the tool from 

the updates site http://accumapupdates.ihsenergy.com/. 

There are two different versions of the downloader, one for IPL data set and another for the ACD. Both are 

available on the AccuMap Update site, or depending on which version of AccuMap you are running you will 

have an executable labeled as either of the follow in the “AccuMap_Downloader” folder: 

 AccuMap_IPL.exe 

 AccuMap_ACD.exe 

**Please note that you will only find one of the above executables in your “AccuMap_Download” folder, 
specifically the one that matches your data type (ie. IPL or ACD)** 
 

Downloader Features 

Checksum Verification 
The downloader utility has a built in checksum to verify file integrity upon download completion. In the event of 

an error or corruption the downloader deletes all files and restarts.  

Pause & Resume 
In the event of a network outage or loss of internet the downloader can pause and resume without having to 

start the process over. The user also has the ability to manually pause and resume the download through the 

application window.  

Details & Logging 
Information about actions that the downloader is taking can be viewed in the “Details” window of the 

application. 

Scheduling 
Using windows Task Scheduler users can set when the application should download the latest release of 

AccuMap. This allows for the downloader to run outside of work hours as not to impact internet/network 

performance.  

VPN-less & Portable 
This application does not require a connection to the IHS VPN, and can be run off of any internet connected 

PC. The application is also portable and requires no installation in order to use.  

 

http://accumapupdates.ihsenergy.com/
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Configuration Notes 
The AccuMap Downloader creates a user.config file that stores the desired/set location for downloaded files. This is 

located in the following directory: 

C:\Users\%USERNAME%\AppData\Local\IHS\AccuMap_IPL.exe_StrongName_fxknvedwlkwtltdz21hw2dkfydynv3fd\1.0.0.0 
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Other Notes 

Wait Chain Issues & Halts 
In some cases when running the AccuMap install shield or workstation setup executable a wait chain deadlock 

may occur. When this occurs the _main.exe application is visible from the task manager, but the application is 

halted, waiting on the release of a resource from another application. In order for the process to continue the 

guilty application causing the halt needs to be found and ended.  

Generally the following applications cause this deadlock, ending these processes will result in the installer or 

workstation setup continuing as normal. 

 itype.exe – Microsoft IntelliType Pro 

 lync.exe – Microsoft Lync 2013 

 setpoint.exe – Logitech Set Point 

To find which process is preventing the installer from running you can use a built in feature of Windows 7 (or 

newer) called Wait Chain Traversal (WCT).  

https://msdn.microsoft.com/en-us/library/ms681622%28VS.85%29.aspx?f=255&MSPPError=-2147217396 

To analyze the Wait Chain in Windows 7 open the Resource Monitor and right click on the _main.exe in the 

CPU window, from the menu the option to “Analyze Wait Chain…” will be available. It will show a list of 

applications or processes preventing the installer from completing.  

 

4K/Hi-DPI Monitors 
Monitors supporting 4K or Hi-DPI resolutions can result in application scaling issues within AccuMap. Currently 

the only solution is to set screen resolution at or under 1900x1200 (Standard 24” monitor) as well as ensure 

Windows text scaling is at the system default of 100%. 

 

Hyper-V 
Please be aware that all Hyper-V related notes are from testing done with Microsoft Server 2012R2.  

In the following notes Virtual Machine will be referred to as VM. 

 Dynamic RAM settings for VM’s in Server 2012 R2 can cause issues with AccuMap. RAM for the VM 

hosting AccuMap should be static.  

 Adjusting the CPU count assigned to a VM that is hosting AccuMap can cause issues with the License 

Manger. Should you need to increase or decrease the CPU count you will need to get new license files 

cut by IHS.  

 Exporting a VM from a Hyper-V server and reimporting it to different server will cause the License 

Manger to fail requiring new license files to be cut. 

 Session based remote environments running AccuMap are currently not very common, however has 

been proven to work properly. Please contact IHS for more information.  

 Clustered Failover environments have not yet been tested but may result in the failure of the AccuMap 

License Manger.  

 Adjusting the RAM levels for the VM hosting the IHS AccuMap & AccuLogs Licensing service can result 

in license file conflicts. 

https://msdn.microsoft.com/en-us/library/ms681622%28VS.85%29.aspx?f=255&MSPPError=-2147217396
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Software Conflicts/Issues 
The following software has known issues or conflicts with AccuMap & AccuLogs; here you will find solutions 

and workarounds. 

 

Adobe Acrobat/Reader – Protected Mode 
After printing a map to a PDF file, regardless of how which tool created the PDF (CutePDF, Acrobat, etc…) 

images may not load properly when viewed through Adobe Acrobat/Reader.  

To resolve this issue ensure that “Enable Protected Mode at startup” is disabled in the Preferences window. 

Depending on which version of Acrobat/Reader is installed this setting will be in one of two locations.  

For version 10 or newer this setting can be found under: File > Preferences > Security (Enhanced)  

For version 9 or older this setting can be found under: File > Preferences > General 

 

Citrix Virtual Desktop Agent Core Services (Version 5.6.400.16) 
In some rare cases a corrupted install/uninstall of the Citrix VDA can result in the Core Analysis feature 

functioning improperly. This is a result of the RSHook.dll entry remaining in the AppInIt_DLLs path.  

Provided that your organization is not utilizing the “Seamless Window” feature in Citrix VDA you can safely 

remove the RSHook.dll from the following registry entry:  

[HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\Microsoft\Windows 

NT\CurrentVersion\Windows\AppInit_DLLs] 

Please note, registry edits should only be performed by qualified individuals, always make a backup before 

doing any work in the Windows Registry. 

AppInIt_DLL Locations 

32 bit DLL on 32 bit systems: 

[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows NT\CurrentVersion\Windows\AppInit_DLLs]  

64 bit DLL on 64 bit systems: 

[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows NT\CurrentVersion\Windows\AppInit_DLLs] 

32 bit DLL on 64 bit systems: 

[HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\Microsoft\Windows 

NT\CurrentVersion\Windows\AppInit_DLLs] 

For more information on the AppInIt_DLL please refer to the follow Microsoft KB article.  

http://msdn.microsoft.com/en-us/library/windows/desktop/dd744762(v=vs.85).aspx 

 

Citrix Universal Print Driver & CutePDF/PDF Creator/Foxit PDF 
While not specifically an issue with AccuMap, we have seeing problems when using the Citrix Universal Print 
Driver in place of the drivers that come packaged within CutePDF, PDF Creator, and Foxit PDF.  

http://msdn.microsoft.com/en-us/library/windows/desktop/dd744762(v=vs.85).aspx
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The result can be seen when printing a Data Card. All headings and bolded text will appear as black bars.  
 
Setting the Citrix printers to use the appropriate drivers will fix this issue.  
 
 

Microsoft GDI+ Errors 
In May 2015, Microsoft issued a security update that resolved some vulnerabilities found in various Microsoft 

products (.NET, Silverlight, Office and Lync).   

A known issue reported by Microsoft, when installing this security updates included crashing when using 

Windows GDI+ to create text outlines.  Microsoft has created a patch that can be installed to correct this known 

issue. 

Some AccuMap users have reported experiencing the GDI+ crash when trying to print.  AccuMap uses the 

Microsoft GDI+ to create various objects within annotations and when printing.  The error message that users 

would experience is attached to this message.   

To read more about this known issue please visit the Microsoft support website: 

https://support.microsoft.com/en-us/kb/3045171 

To resolve the GDI+ issue please use the following link, which can also be found on the Microsoft support 

website, to install the security update: 

https://support.microsoft.com/en-us/kb/3065979 

We understand that installing security updates requires coordination and time.  For a quick fix, IHS has found 

that by installing the AccuMap font files to your local machine users will no longer encounter this error when 

printing.   

You can find the AccuMap font files in your current install within the Bin.Map folder.  There are 4 True Type 

Fonts you will need to install: afsym405, ahsym405, awsym404 and shsym401. 

 

Surfer (Versions 7, 8, & 9) 
There are a number of reported issues with versions 7, 8, and 9 ranging from application instability to user 

access rights inside of Window’s Domains that are resolved by running version 10 or higher.   

 

Cloud Based Solutions 
AccuMap is not officially supported when run from cloud based server solutions. For more information please 

contact IHS. 

https://support.microsoft.com/en-us/kb/3045171
https://support.microsoft.com/en-us/kb/3065979

